Guided Tour
For
School Libraries
Introduction
Alexandria — best known for its power and ease of use — is designed for single libraries as well as large districts and may also be configured as a Distributed Union or Central Union catalog. It is a fully-integrated solution including: OPAC, Circulation, Cataloging, Web, Subscription Management, Orders, Budgets, Patron Management, Word Processing, E-Mail Notices, over 15,000 Reports, Built-In Server and Web Server, Advanced Bookings, SIF and SIP2 capabilities, and much more! Alexandria offers the best cross-platform library automation solution for Windows and Macintosh.

Getting Started
This guided tour takes you through a full-working version of Alexandria and will show you many of Alexandria’s easy-to-use features and integrated capabilities. For your first tour through Alexandria, we recommend you follow the guide suggestions using the sample data. After the guided tour, feel free to add actual items and patrons from your library. This will give you an excellent idea of how Alexandria will benefit you. If you would like to go through the Guided Tour a second time, simply reinstall the demo.

Starting the Demo
Place the COMPanion CD into your CD player. For Windows installations, go to My Computer, double click the CD icon and find the Alexandria Demo installer for windows. For Macintosh, double click the COMPanion CD icon when it appears on your Desktop, then find the Alexandria Demo installer for Macintosh. The larger of the two installers includes multimedia attachments that you will need in order to tour the multimedia functions in Alexandria. If you choose the smaller of the two files, multimedia attachments will not be installed on your computer and you should skip the Multimedia section of the tour.

If you have downloaded the Alexandria Demo Installer for Windows from our web site, click on the file in your downloads list, click on OK when asked if you want to launch the file, then, click on Install. For Macintosh, double click on the Alexandria Demo Install icon and follow the prompts given.

QuickTime must be installed on your computer to view the demo properly. If you do not have QuickTime installed, you can install it from the COMPanion CD.

Entering Data
Where you read text written like this: Simple Text, type it into the program. Alexandria users enter data with barcode readers and do not need to press the key after each scan. This guide assumes you do not have a barcode reader, so you
will need to press **ENTER** after you type your information. If you have any questions, please call us toll-free at 1-800-347-6439.

**Circulation**

Most Alexandria functions are performed or accessed from the Circulation window. Alexandria automatically displays all commands entered from the keyboard and barcode reader in the Command Line.

**Check Out**

First, let’s check out *A Child Called “It”* (3187) to Camille Arnold.

- Type (or scan) Camille’s barcode (1003) **ENTER**.
- Type (or scan) barcode for *A Child Called “It”* (3187) **ENTER**.

Look at Camille’s record in the Current Patron pane. It shows her name, her barcode, the policy she is on (9th Grade), her homeroom, and her picture. It also shows a summary of her account — how many items she has checked out, how many of those items are overdue, how many holds, in-stock holds, reservations and reserves she has, and the total amount she owes in fines. Policies govern how many items can be checked out by the patron, how many holds can be placed, etc.
Next, look at the item information for *A Child Called “It”* in the **Current Item** pane. It shows the title, the copy barcode, its policy (Non-Fiction), the call number, the status of the copy, replacement cost, condition code, number of copies available, and the total number of copies.

Notice that the **Transaction Log** at the bottom of the window shows that Camille Arnold on today’s date and at the time indicated, checked out *A Child Called It*, barcode 3187. Note the due date at the far right. This due date is calculated based upon the policy assigned to that item. Click on the **Copy Stats** button at the bottom of the **Current Item** pane. Notice that you can see not only the patron who currently has the item checked out, but also the previous six patrons who checked the item out and the date and time they checked it out.

Let's check out *B. Franklin, Printer (3027)* to Marijane Lou Coots (1036).

- Type (or scan) Marijane’s barcode (1036) **[ENTER]**.
- Type (or scan) the barcode for *B. Franklin, Printer (3027) **[ENTER]**.
- The message alerts you that the item is currently checked out to Todd Malta. This copy, somehow, managed to get back on the shelf without being checked in. Choose the default answer, **Yes**.

Darla Anderson wants to check out *Cheerleading in Action (4012)*.

- Type (or scan) Darla’s barcode (1001) **[ENTER]**.
- Notice that she has three items checked out and that she has a fine of $2.50. The fine amount is beneath the limit that will keep her from checking out additional items according to the library's policies. Let’s see the titles of the items she has checked out and for what the fine was charged by clicking on the **Details** button at the bottom of the **Current Patron** pane. The patron’s details can be printed by clicking on **File** and selecting **Print**. Close the **Details** window.
- Now, type (or scan) the barcode (4012) **[ENTER]**.
- A dialog window has opened which shows that she already has the maximum number of items checked out. You have the option to override or cancel the transaction. Click on **Override**.

Camille has decided she does not want *A Child Called “It”* (3187) and she wants another item instead. Check it in.

- Type **b3187 **[ENTER]**. Note that the **Transaction Log** shows the item checked in, the information in the **Current Item** pane shows the status of
the item as Available, and the mode (drop-down menu next to the Command Line) is Check Out. You are ready to check the new item out to her.

- Type or scan the barcode of her new item (3411).

Bookdrop (Check In Mode)

To quickly check items in, type b ENTER or change the mode using the Mode drop-down menu. The Transaction Log displays the message “Start Bookdrop.” Type the following item barcodes. Notice how the screen changes with each one.

- 3013 ENTER — Because this item is overdue and fines are charged, the Fine window opens. Let’s charge the fine, so, click on Process.

- 3193 ENTER — This item has a hold on it and you are notified of the hold so that the item may be set aside and you may print a notice to inform the patron who had placed the hold. Click OK.

- 3085 ENTER — This item was not checked out. Notice that the Transaction Log indicates this and tells you that the inventory date was changed. Alexandria performs a continuous inventory changing the inventory date every time an item is checked in or out.

- 8027 ENTER — This item is from another library in a Central Union setting. It has been put In Transit to its home library.

- To exit Bookdrop mode, either type a period (.) ENTER or use the Mode drop-down menu to select Check Out.

Locate a Patron

There are several different commands that you may use to locate a patron.

One way to locate a patron is using the Homeroom pane. Let’s locate Maggie Kennedy in Mrs. Dobbins’ homeroom.
• Click on the **Homeroom** subtab of the **Circulation** tab.

![Image of Homeroom subtab]

• Highlight the desired homeroom in the left pane; then, double click on the student in the right pane.

• Click back on the **Transaction Log** subtab.

Another way is to use one of the two **Locate** commands. The **LF** (**Locate Patron by First Name**) command will locate the patron by first name or you may use the **L** (**Locate Patron by Last Name**) command to browse the list of patrons in last name order. (NOTE: Although the commands are shown in uppercase for readability, they may be typed in lowercase. The space between the command and the text is important to distinguish between the two commands.)

Locate Randy Everill using the **LF** command.

• Type **LF ran** **ENTER** to find a patron whose first name begins with “ran.”

Now, let’s locate Lonnie Amstead using the **L** command.
• Type **L amst** and double click on her name to make her the **Current Patron**. Leave Lonnie on the screen as the **Current Patron**. We will need her for the next exercise.

![Patron Lookup](image)

**Locate Items with Title, Author or Call Number**

Items can also be found from the **Circulation** window by title, author or call number. If Lonnie Ann Amstead wants a specific item, but has not checked the catalog, you can verify the item’s status for her during circulation.

• **Searching by Call Number (C)**— Type **c 900 ENTER**. Double click on the desired title or click **Select** to make it active.

• **Searching by Author (SA)**— Type **sa PAU ENTER**. Again, double click on the desired title or click **Select** to make it active.

• **Searching by Title (T)** — Type **t diary ENTER**. Double click on **Diary of a Wimpy Kid** to make this title the **Current Item**.

**Place Hold**

Lonnie wants to put a hold on this book.

• Just type **h= ENTER**. The **H** is the command to place a hold and the **=** command tells Alexandria to execute the current command for the **Current Item**.

Todd wants to place a hold on the book that the patron in front of him is checking out.

• Type Todd’s barcode: **1013 ENTER**.
• Type h 3444 [ENTER] to place a hold on the title, Baby Whale Rescue. Alexandria places a hold on the title — not on a specific copy. If there were more than one copy of this title, when a copy is returned, it fills the hold that is first in the queue for that title. If a copy was available on the shelf, you would also have been notified of that.

Renew Items

• To renew a single item, type r 3190 [ENTER]. The patron number does not need to be entered.

• To enter Renewal mode, type r [ENTER] or select Renewal from the Mode drop-down menu. When finished with Renewal mode, type a period (.) [ENTER] to exit the mode.

Another way to renew items is from the Renewal window. Mark Arias has five items out and would like to renew three of those items: Baseball’s Boneheads, Bad Boys & Just Plain Crazy Guys, Bar Graphs, and The Baltic States.

• Type Mark’s barcode: 1002 [ENTER].

• First, there is an Alert Note. His parents have requested that he not be allowed to check out any books on witchcraft. Click on Proceed or press [ENTER].

• Click on Renewals subtab of the Circulation tab. Note that Bar Graphs is in red. It’s overdue and he’ll have a fine on that item.
• + click (Macintosh) or + click (Windows) on each of the titles so they are highlighted as in the screen shot below.

• Click on Renew at the bottom of the window.

• The book about baseball’s boneheads can’t be renewed because there is a hold on it. Click on No since he doesn’t have the books with him.

• Click on OK for Hold notice.

• If your library charged fines, an Alert window would appear. If Mark paid the fine when he renewed the overdue item, you could enter the payment amount, then, click on Process and Print Receipt and the payment would be recorded. You can also forgive the fine or a portion of the fine by entering the amount on the window before clicking Process. Click on Process on Fine window.

Charging for Damages

Alexandria provides a fast and easy way to charge for damages. You may set up damage codes and set amounts using System Preferences or you may use the Custom Damage code, enter an amount to charge and the type of damage.
Camille Arnold is returning *Computers* and you notice that there are a couple of torn pages. The damage is not sufficient to withdraw the item; however, you want to charge her $4 and note the damage.

- Type `b4196` *ENTER*.
- Type `DL` *ENTER*.
- Enter 2 torn pages in Notes field.
- Enter 4 in the Fine Amount field. You do not need to put the decimal and the 00; Alexandria recognizes 4 to mean $4.
- Click on OK.
- Click on the Notes button at the bottom of the Current Item pane. Notice that the damage note shows there.
- Notice that the amount charged is showing as a Fine on Camille’s record. Click on Details at the bottom of the Current Patron pane and notice that you can see there the item on which the fine was levied and the reason as well as the amount.
- Type `X` to clear the Current Patron and Current Item panes.

**Circulation Commands Help**

You can get immediate, on-line help for using Circulation commands by clicking on the Command Help tab in the middle of the Circulation window. This on-screen assistance is available for all Circulation commands.

- Click on the Command Help tab in the middle of the window.
Choose the appropriate command group — **All Commands, Common Commands**, or **Data Manipulation Commands** — using the subtabs for this tab.

Use the scroll bar for the left pane to look through the commands for the desired command or enter a search term in the field at the bottom of the tab. For example, click on the **All Commands** subtab, then, type **Catalog** in the search box at the bottom of the **Command Help** tab.

Highlight the **Catalog Items** command in the left pane. The right pane gives instructions on how to use the command you chose.

Click the **Insert Command** button to put the command in the **Command Line**. Notice that a **V** is now in the **Command Line**.

Type **A Beehive Awards 2010** [Enter]. Notice that the **Mode** drop-down menu shows **Assign Keywords** and that there is a field next to it showing A Beehive Awards 2010. The A stands for awards and tells Alexandria to put the text following the **A** in the **Awards Notes** field of the item’s records.

Now, in the **Command Line**, type (or scan) 3411 [Enter] 3455 [Enter] 3292 [Enter].

Now, let’s use a couple of other commands to add an additional title.

Type **T Diary** [Enter], double click on the first entry for *Diary of a Wimpy Kid*.

Type **=** [Enter]. Using the **=** command in this way allowed you to put the same entry in the **Awards Notes** without using a barcode.

Type a period (.) [Enter] to exit this command and return to **Check Out** mode. Later, when we discuss searching, we’ll show you the results of this convenient method.

Scroll down the list of commands to see other **Circulation** commands.
Click on some of the commands to explore. Click on the Circulation tab and the Transaction Log subtab when you are finished.

**Reserves**

Items on reserve will not circulate until removed from reserved status and placed back into circulation. Kerri Dobbins has asked you to reserve *The Usborne Computer Dictionary for Beginners*.

- Type `1020 ENTER` to make Kerri Dobbins the **Current Patron**. Then, type `j 8985 ENTER`. The J command places a reserve on the barcode 8985.

**Reservations**

A Reservation holds a specific copy for a designated time in the future. For example, Keri Dobbins has a unit on astronomy in April and wants to reserve item 3168, *Venus*, for the second full week in April.

- Type `1020 ENTER` to make Keri Dobbins the **Current Patron**.
- Type `g 3040` to place this item on Reservation.
- A calendar displays for you to select the dates for the reservation. Click the drop-down menus for the month and year to set the month and year to next April.
- Click on the Monday of the second full week in April and, with the mouse button held down, drag the cursor to the Friday of the same week.
• Click on Save. Notice that processing days have been included before the item’s reservation date. This gives you time to check it in from the previous patron and have it ready for the requesting patron.

After the reservation is set, the item can circulate until the reservation date. If the due date for the item conflicts with the reservation, you will get a warning message.

• Type X to clear the Current Patron and Current Item panes.

Preferences
Using System Preferences from the Edit menu, you can customize Alexandria at any time to meet your library’s needs. Using preferences, you can define library policies that determine how each type of item is circulated and how patrons can use your library. For example, you can set policies to determine the loan period for items and how long items with holds can be held for a patron. You can even make exceptions to those policies for certain groups of patrons.

Adding a New Policy
Adding a new policy is so easy in Alexandria. Since Alexandria keeps track of statistics based upon patron and item policies, you may find that having many policies representing the various parts of your collection and the different grades you serve will be extremely beneficial in providing specific usage information that will influence your ordering and weeding.
Since most of your policies for items will have the same loan period, same fines value, etc., we will set the Standard Item policy which has already been established to the desired values and, then, duplicate that policy to make our new policy. Let’s make a policy for the 000s.

- Go to Edit on the menu bar and select System Preferences.
- Click on Policies in the Circulation category.
- On the right side of the Policies window, set the Item Policies drop-down menu to Standard Item.
- Look at the values on the items side of the Check Out tab. If they do not suit your library situation, change them.
- Click on the Overdue tab next. Review and change those settings on the Item Policy side of the window.
- Next is the Holds tab. The only decision necessary on this tab is whether or not to allow holds on items assigned to this policy.
- Click on the Reservation tab. If you wish to allow reservations, set the Transaction Period and how many processing days to require between reservations.
- Now for the last tab. This is just to see what it contains since no changes will be necessary for the policy you are establishing.
- Click on the Add (+) icon at the bottom of the Item Policy side of the Policies window.
- Enter 000s in the Policy Name and give it a Policy Short Code of 000, then, click on OK.
- Click on Save in the upper-right corner of the window.

That’s all there is to it! You have made your first Alexandria policy. Easy, wasn’t it?

Make an Exception to a Policy

As part of your policy, non-fiction books circulate for only 14 days. You would like to allow your staff to check them out for 28 days.

- Select System Preferences from the Edit menu and, then, click on Policies from the Circulation category.
- Change the **Patron Policy** drop-down menu at the top of the patron side to **Staff**.

- Change the **Item Policy** drop-down menu at the top of the item side to **Non-Fiction**. As the window currently is viewed, these are the settings for these policies. Note that the **Exceptions** button is grey and the **Check Out** tab only has the name of the tab.

- Click on the **Exceptions** button in the middle of the grey band at the top of the tab. Notice that it changes to red.

![Image of Alexandria v6 Guided Tour](attachment:image.png)

- On the item side, change the **Transaction Period** to 28. Click on **Save** in the top-right corner of the window. Notice that the **Transaction Period** is now outlined in red.

![Image of Alexandria v6 Guided Tour](attachment:image.png)

- Click on the **Exceptions** button. Notice that it has now turned yellow. Note that there is now a yellow **Alert** symbol on the tab.

![Image of Alexandria v6 Guided Tour](attachment:image.png)

- Change the **Patron Policy** to Standard Patron. Notice that the tab does not have the **Alert** symbol and the **Exceptions** button is grey. This indicates
that there are no exceptions for the Standard Patron combined with the Non-Fiction policy.

Setting the Library Calendar

Alexandria is shipped with a default library calendar. Using System Preferences, you can change the settings on the calendar and also define other calendars to be used.

- Select System Preferences from the Edit menu and, then, choose Calendars from the Circulation category.

- To show that the library is always closed on Fridays through the end of the year, hold down the ⌥ for Macintosh users, or Alt for Windows users, then click on the column heading for Friday (Fri). All the Fridays display as closed.

- To show the library is closed December 22 through 28, choose December from the Month drop-down window. Click on December 22 in the calendar, then, holding the mouse button down, drag the cursor to December 28. Each of the days you choose is marked Closed. You may do this for future holidays as well.

- If you make a mistake and drag over a day that should be open, click twice on that day to remove the Closed status.
If there is a date on which you want all books returned, for example, the fourth Monday in May, change the Month drop-down menu to May and the Year drop-down menu to the appropriate year. Click twice on the third Thursday’s calendar space. Note that the date is marked Period Due. All books that would have a due date after this date will be set as due on this date. Books due before this date will be due on dates determined by the policies assigned to the items.

- Click on Save.

Terminology and Date Formats

Alexandria allows you to assign your own terminology to certain fields in both the Patrons Management and Items Management modules. These same terms will be applied to reports and utilities.

- Click on the Show All button at the top of the System Preferences window.

- Click on Terminology in the System Administration category.

- Click on the Patron tab.

- Change the term for 2nd Phone Number (Mobile) to Cell Phone.
• Click on the Dates tab.

• Note that you can change the format from M/D/Y to D/M/Y or Y/M/D. You may also change any of the other formats to the desired order.

• Click on Save.

• Close the System Preferences window by clicking on the red dot (Macintosh) or on the X (PC) at the top of the window.

Patrons

The Patrons management module stores information about library patrons. Most of this information can be imported from existing data sources such as your school information system using a tab-delimited file.

• To look at a patron record, go to Show on the menu bar and select Patrons.
Add Patron

Add yourself as a patron.

- Click on the + at the bottom of the Patrons List pane (left pane).

- Alexandria automatically assigns the next available patron barcode number according to the Patrons System Preference settings. Use this number or input a number of your choice. \( \text{TAB} \) from field to field and complete the information.

- Select a policy from the Policy drop-down menu and the appropriate sex from the Sex drop-down menu.

- Click on the Contact Info to fill in the necessary fields on this tab.

- Click on the Notes tab to enter notes for this patron. The text that you enter in the Alert Notes field will display on the Circulation window whenever the patron’s barcode is entered or a book is returned by this patron.

- Click on save in the upper-right corner of the window to save the data you have entered.

Searching for a Patron

- Click on the Search (magnifying glass) at the bottom of the Patrons List pane.

- Click on the drop-down menu next to the Grade field and select 8 \( \text{ENTER} \).

- Notice that the patrons listed in the Patrons List are those students in the 8th grade.
• Close the Patrons management window when you are finished.

Items

Information about each item in your collection is kept in the Items management module. This data can be typed in directly, imported from a vendor or imported as MARC records retrieved quickly and easily from a z39.50 server using Title Assistant. Title Assistant allows you to search multiple z39.50 databases to locate and import a MARC record for the new item.

Add Items

Before we add our first item, let’s select some z39.50 servers for Alexandria to search. You may select up to twenty to be searched at the same time.

• Go to Edit on the menu bar and select System Preferences.

• Click on Address Books in the System Administration category.

• In the Address Books List pane (left pane), click on Standard z29.50 Address Book.

• To select a server, double click on the name of the server in the Addresses pane (right pane), then, click on the drop-down menu in the upper-right corner of the window and select Hide on Researcher. Click on OK.

• Suggested servers to select:
  MA - Public - Metro Boston
  MA - Special - North of Boston Library Exchange
  MT - Montana Shared Catalog

• Click on Save in the upper-right corner of the System Preferences window.

• Close the System Preferences window.

Now, you are ready to use Add Title Assistant!
- To add an item, go to Show on the menu bar and select Items. Then, click on the + at the bottom of the Items List pane (left pane).

- You may search by ISBN, Title, etc. Click on the ISBN field and type (or scan) the following ISBN: 0062740105 ENTER.

Alexandria will search your collection first so you don’t add a new title record for an item when it already exists in your database and you only need to add a copy to the existing record.
The results will appear in the MARC Search Results window.

Note that Alexandria rates the results. Green indicates a match on the ISBN and the longer the line, the higher that record has been rated. For instance, more subject headings, a summary, additional notes, etc. Scroll through the list at the top and compare the MARC records as they shown in the bottom pane of the window. Highlight the one you consider the best and press ENTER.

Use the TAB to move from field to field and type other required information or select from drop-down menus where they are provided. You may change or add to any field in the record.

Enter the call number for the item. If the MARC record that you selected had a tag containing the call number, that call number would have been entered in the Call Number field. You may change the call number to fit your collection or add the appropriate Cutter information to the number provided.

Select the policy that fits the item from the Policy drop-down menu.

Click on Save. You will be asked if you want to add a copy. Click on Yes.

Alexandria automatically enters the next available item barcode according to your Items System Preferences. You may, of course, change this number if you desire.

Note that the Replacement Cost has been entered for you based upon the policy that you selected.
Alexandria includes a preference to automatically search for cover art. If you have entered the ISBN in the ISBN field, Alexandria will look for, find and insert the cover art for you. This makes the OPAC so much more appealing to the patrons!

- Click on Save.

**MARC Record Editing**

While most Alexandria users are comfortable editing items by the simple “fill in the blank” method, some prefer cataloging in MARC format. Alexandria accommodates both types of cataloging, and record changes made using one method are simultaneously changed in the other format as well.

- Click on **Show** on the menu bar and select **Items**.

- Click on the **Search** icon at the bottom of the **Items List** (left) pane.

- Enter the title, *100 Cars 100 Years*, in the **Title** field and press **Enter**.

- Double click on the title in the **Items List** pane, click on the **Lock** icon at the top of the **Item** record to unlock the record.

- Click on the **Action Menu** icon (gear) next to the **Lock** and select **Switch to MARC view**.

- Scroll down in the record to the **650** tags.


- Cars is an incorrect subject heading. Click on the 650 tag for Cars. Click on the - at the bottom of the pane to remove this tag. Answer Yes when asked if you want to remove the tag.

- Repeat this for the 650 tag containing Automobiles History.

- Click on the + at the bottom of the pane.

- Click on the drop-down menu on the Select Record window and scroll down the list to find and select 650. Click on OK.

- In the new 650 tag that has appeared in the record. Notice the watermarks for the various fields for this tab. Even a novice will know what type of information to enter in the various fields. Just start typing in the field to enter the information and the watermark will disappear. Click on the watermark for the a field and enter Automobiles. Next, click on the watermark for the x field and enter History.

- Click on Save.

- Click on Add to List when the Subject Search window opens. This is the Authority Control feature of Alexandria that helps you be consistent in your entries if you elect to turn on Authority Control in your System Preferences. Then, click on OK.

- Click on the Action Menu icon and select Switch to Item View.

- Click on the Subjects tab. Notice that the changes you made are reflected there.

Cataloging or Adding Web Sites

Adding web sites can be very beneficial. For instance, adding links to web sites with lesson plans for a novel would provide a valuable resource for your teachers.

Let’s add a web site to Sadako and the Thousand Paper Cranes.

- Click on the Search icon at the bottom of the Items List (left) pane.

- Enter the title in the Title field.

- Highlight the title in the Items List pane, click on the Lock icon at the top of the Item record to unlock the record, then, click on the Links tab.

- Click on the + at the bottom of the Item Record (right) pane.
• Enter San Diego County Office of Education Teacher CyberGuide in the URL Name field, then, enter the following URL in the URL Location field: http://www.sdcoe.k12.ca.us/score/crane/cranetg.html.

• Click on OK.

• Click on Save.

**MARC Utilities**

Alexandria’s MARC cataloging abilities are unmatched by any other library automation system.

**Quick MARC Export**

Alexandria allows users to easily share their information with other automation users, even those on other automation systems.

Suppose another librarian receives *Across the Steel River*. You have the same item in your collection. The other librarian e-mails you a request for the MARC record.

• If you are not in the Items window, go to Show on the menu bar and select Items.

• Click on the Search icon at the bottom of the Items List (left) pane, then enter the title in the Title field and press ENTER.

• Highlight the title in the Items List pane, then, click on the Action Menu icon at the bottom of the pane and select Export.

• From the Format drop-down menu on the Quick Export window, select the appropriate format. Let’s use MicroLIF. Click on OK.

• Click on Save on the Save window after you have selected a destination for the exported file.

It’s that easy! Now, the file containing the MARC record may be attached to an email to your colleague or burned to a disk and mailed.

• Close the Items management window when you are finished.

**Inventory Helper**

Performing inventory using Alexandria’s Inventory Helper is as easy as 1-2-3. If you are logged in as an operator, Alexandria will retain the list of items that you have inventoried and any Exceptions Notes no matter how many times you open and close Inventory Helper until you click the Finish Inventory button of the fifth
tab. This is so helpful because you can even quit in the middle of a shelf and know exactly where you need to resume inventory the next time you open Inventory Helper.

- First, click on Edit and select System Preferences.

- Click on Operators, click on the Require Operator Login, then, click on Save. Close the System Preferences window.

- Go to File on the menu bar and click on Log Out. When the Log In window opens, type Alex in both the Login and Password fields.

- Click on Tools on the menu bar and select Inventory Helper.

- Click on the second tab, Inventory Settings. Enter 000 and 099 in the Call Number Range fields. Notice that if you do not want Alexandria to report every item that is inventoried out of shelf list order, you may check the box, Ignore Call Number Order.

- From the Site Code drop-down menu, select CDL; from the Policy drop-down menu, select Non-Fiction. Inventory Bookdrop will check in any items that have a status of Checked Out or Lost.

- Click on the Begin Inventory button in the bottom-right corner of the window.
Click on the third tab, **Scan Items**, and begin entering the barcodes listed below pressing **ENTER** after each barcode: 3358, 3409, 3556, 3889, 3411, 3154, 4195, 4196, 5910, 3764, 3389, 5905, 6901, 5420, 4030.

Note the messages in the **Exceptions Note** column and in the **Status Column**.

Click on the fourth tab, **Review**. Notice that Alexandria provides a running tally of how many items have and have not been inventoried. You may click on any of the report links to have the chosen report run. Don’t worry,
Alexandria prints to the screen first so you will not waste any paper printing reports you just want to view.

- Click on the last tab, Finish. Notice that Alexandria provides some links to check to run final reports when you have completed inventorying the section of your library. Notice that you may have Alexandria set all items not inventoried to Lost by just checking that option and clicking on the Finish Inventory and Clear All Settings button in the bottom-right corner of the window.

- Close the Inventory Helper window when you are finished.

Searching/Researcher

Alexandria’s web-based catalog provides several search interfaces for various abilities and needs. You may also search for items using many different pieces of information. For example, you can search any word in an item’s title, author’s first and last name, subject, summary, and notes. Even the publisher and publication date can be searched. Because Alexandria is web-based, your patrons may search your catalog from anywhere — library, classroom, or from home.
Simple Searching

- From the Show menu, select Researcher. Type **dogs** [enter] in the Search field. The next screen lists all the results of the search.

- In the upper-left corner above the list of items are two drop-down menus. The first allows you to switch from the **Full** view for the results to the **Brief** or **Cover Art** view. Change to **Brief** view and note the difference in the display. Change to **Cover Art**, then, back to the **Full** view.
Click on the second drop-down menu. Notice the different sorts that are available. Select one of the other sort options and see how the display changes.

Click on one of the titles. This opens the **Items Details** for the title you selected. Note all the links shown in blue. If you click on any one of the blue links, Alexandria will perform a search for the term(s).

Notice the scroll bar behind the item record. Move your cursor off the **Item Details** and notice that the scroll bar with the cover art for the other search results comes to the front. Now use the **Forward** and **Back** arrows at the ends of the scroll bar to move forward and back through the list. Click on another item and see how that item’s details comes to the front.

Click on the **Close Details** button in the upper-right corner of the window. Let’s take a look at the **Results Filters** on the left side of the window. Put your cursor on the **Awards** line. Notice that there are 5 results that have received awards and a list opens showing you the names of the awards.
Click on Caldecott Medal/Honor 2002 to see the item that received this award.

- Let’s return to the full list of results. At the top of the window, click on Searched: Dogs. Notice that in the left pane under Lists, Past Searches shows 1. Alexandria keeps track of past searches and you may click on Past Searches at any time to see a list of those searches. Clicking on one of the past searches will initiate that search again. You may also return to an Item Results display for an item you have previously viewed by clicking on Past Items and selecting that item from the list shown.

Search Filters

Whether using the Simple or the Advanced search option, Alexandria provides search filters to further limit your search results. Let’s limit our results for dogs a bit using the Filters. Let’s look for items with a publication year of 2000.
- Click on the Filter drop-down arrow below the main Search pane.

- Enter 2000 in the Publication Year field.

- If you support Accelerated Reader, Reading Counts or Lexiles for a reading program, there are various filter options available to use for those programs.

- If you are part of a Central Union system or you are a school in a district that has Alexandria WAN (Wide Area Network) capabilities, you will be able to search the collections of other libraries in your district using the Select Copy Site drop-down menu in the left column of the Filters area.

- Click on Search.

- Clear the filter using the Clear link next to the Publication Year field label. Click on New Search to be ready for the next section of the Guided Tour.
Advanced Search

The Advanced Search enables you to use Boolean search strategies and to have far more search options.

- Log in as Darla Anderson. Click on Log In at the top-left of the window. Enter 1001 in the Login field and Anderson in the Password field. Alexandria automatically assigns a login and password to each patron; however, you may use whatever you would like when using Alexandria in your library. The Login is the patron’s barcode and the Password is the patron’s last name. Click on Log In in the bottom-right corner of the Log In box.

- Notice that Darla’s information shows on the window. You will set your preferences to determine what Darla can see and do on the Researcher window. Noticed that Log In has changed to Log Out at the top of the window and it shows Darla Anderson’s name next to Log Out. Logging in
enables Darla to make and save lists and to submit reviews of items. Close this window by clicking on the X in the upper-right corner.

- Click on the drop-down menu directly to the right of the Search field and change it from Simple to Advanced.

- Enter Greek in the first Search field, change the Boolean Operator from And to Or next to the second Search field and enter Roman in that Search field. In the third Search field, you want to enter mythology, but you don’t know how to spell it. Alexandria to the rescue! Type Myth and click on the Browse icon (magnifying glass) in the third Search field. The Browse window will open with the first word starting with myth highlighted. Double click on mythology and click on Search after mythology appears in the third Search field.

- Click on Add to List for the first title. Notice that two options are given — Temp Basket and Default. Default is only shown when a patron logs in. Items added to the Default Basket will be saved until the patron deletes them from the list, so every time Darla logs in she will have those items still on her personal list. Temp Basket is just that, Temporary. Items listed in
either basket can be printed in a variety of formats. Simply click on the list, click on **Print**, then, select the format you desire.

- Darla wants to write a review on *Ancient Greece* by Andrew Langley. Locate this item in the list, click on the **Review stars** and select **Add Review**.

- Choose the number of stars to give the item, then enter text for the review. Click on **Submit**.

- Click on **Log Out**. Now, click on **Log In**, but this time, you will use an **Operator** login and password. Type **Alex** in both the **Login** and **Password** fields and click on **Log In**. The **Researcher** window will change to the on-line **Web Librarian Circulation** window. Alexandria recognizes that the password and login belong to an operator and not a patron, so it opened the **Circulation** window. Yes, you can circulate items, catalog items, perform inventory and many other functions via the Web!
• Click on the **Alexandria** icon (Infinity symbol) at the bottom of the window and select **Review Management**.

![Review Management](image)

• Click on the **Lock** at the top of the reviews to unlock the window. Click on **Set Accepted**, then click on the **Alexandria** icon again and click on **Log Out**. This will put you back to the **Search** window.

![Review Management](image)

• Type **Ancient Greece** in the **Search** field and click on the **Title** icon. Notice the **Review stars** show the review rating. Click on the stars, then click on **Read All Reviews**.

• Close the **Review window**.

• Click on **New Search**.

**Explore**

Alexandria Explore provides an iconic search interface perfect for the English-as-a-Second-Language individual or the younger patron whose typing and/or spelling skills are somewhat rudimentary. This search interface is fully customizable using **Explore Builder** which is found under the **Tools** menu on the **Circulation** window. **Explore** buttons can be programmed to perform a search, launch a URL, or open...
another Explore pane. Use the icons and search panes as they are, make additions or deletions to the panes, or delete everything and start from scratch to make it totally your own creation!

- Click on the Explore icon in the Explore section of the Researcher.

![]()

- Click on Nature, then, on Human Body, then, on Muscles. Clicking this button performs a search for item records containing the word muscles.

- Click on Explore: Nature at the top of the window, then click on the Astronomy button, then on the Astronomy Pictures button. This button launches the Astronomy Picture of the Day web page.

- Click on New Search.

Cataloged Websites

- In the Search field, type Sadako and the Thousand Paper Cranes and click on the Title icon.

- Click on the title, then look for the blue link for the San Diego County Office of Education’s CyberGuides website and click on it. Alexandria will launch that website.

- Close the browser window when you are finished.

Reports

Alexandria’s Reports module provides you with an abundance of reports to meet your every need. There are over 15,000 possible reports built into Alexandria and these reports are grouped for ease of access.

Cataloged Web Site:
A Web site that has been added to your collection as though it was a standard item. Patrons can click on a hyperlink of the cataloged site to go directly to it.
Many sample reports have been included for your use either as they have been set up or as a starting point for customizing to suit your own needs. But the best feature of the Reports module is that you can schedule reports to run automatically. Imagine having your overdue notices run, made into PDFs, attached to emails and sent while you are home sleeping. It’s possible with Alexandria!

- Go to Tools on the menu bar and select Reports.
- Click on the appropriate tab that represents the type of report you want. For this example, click on the Circulation tab. Next, click on the subtab that represents the best choice for the report you want to generate. Click on the Listings subtab.
- Click on the Add (+) icon in the bottom-left corner of the window to open the Editing New Report window.
- Select from the Report Type drop-down menu to Circulation Listings Detailed. If the Format drop-down menu was present, you would select a format for the report. Select the Sort By option from that drop-down menu. For this example, select Patron Name. Notice that several checkboxes are available. Click the box for Include Charges.
- Several Select By options have already been added to this report. Let’s add another one to designate a specific homeroom as the focus for this report. Click on the Add (+) icon in the bottom-left corner of the window. Set the Boolean Operator drop-down menu to And and change the Select By drop-down menu to Homeroom. In the fields that appear, enter Wishard.
- Now, click on the Schedule tab. Mrs. Wishard’s class comes to the library on Thursdays, so you want to run her overdue list on Friday. In the Run...
next on field, click on the Calendar icon and, then, click on this Friday’s date. While you may change the time, 1:00 AM is fine for our purposes. Set the Repeat drop-down menu to Weekly, then, click on Friday so the report will repeat weekly on Friday. Enter 1 in the Every field. You want to know if the class had any overdues, so check the Send Email Notification box and enter your email address in the field provided.

- Next, click on the Locations tab. Set the Output to drop-down menu to Email Attachment and enter an email address for Mrs. Wishard. Set the Output Format drop-down menu to PDF and enter Wishard Overdues in the Output Filename field.

- The report needs a name and to be saved as a favorite. Click on the Overview tab. Give the report a Name (Wishard Overdues), Description and
add Notes. Also, check the Favorite box if you want the report listed in your Favorites.

- Click on Save.

Now, every Friday at 1:00 AM, Alexandria will prepare Mrs. Wishard’s overdue list, make it into a PDF, attach it to an email and send it to her. Yes, the initial setup does take a few minutes, but, once it is setup, you would only have to change the report’s name, homeroom name, or the day of the week if your schedule changes or Mrs. Wishard leaves.

Once a report is saved, you may search from the Saved or Favorites lists to find the report you need.

Of course, you will have reports that you only want to run once and there is no reason to go through the scheduling steps. You will just set the Selection tab to the proper settings and click on Print or Print PDF in the lower-right corner of the window. You won’t waste any paper with Alexandria because it prints to the screen first and then you select Print from the File drop-down menu to print a hard copy if that is what you need.

Explore the many reports available to you by clicking on the various tabs and subtabs in the Reports window. Remember, you can see the results of the report right on your screen and you’ll not have to worry about wasting paper.

- Close all reports windows when you are finished with reports.
Additional Modules in Alexandria

Alexandria provides additional modules at no extra cost that allow you to manage your vendor information, budgets, orders, and subscriptions — everything in one place and always at your fingertips.

- To access one of these modules, go to Show on the menu bar and select the desired module.

Vendor Information

Track vendor information such as address, contact information — even the barcode range that you sent the vendor as well as the next barcode. No more searching for those illusive pages of notes!
Budgets

Always know where you stand on all your budgets by recording that information in the **Budgets** module. Alexandria will adjust the amounts accordingly as items are received.

Orders

Alexandria provides you with a quick and easy way to generate your orders. It will even figure discounts and additional charges such as shipping, cataloging, etc. Not only will it generate these orders, but when items are received, it will adjust the budget figures accordingly, track items requested by specific patrons and let you
notify them that the items have arrived, send claim letters, and transfer items not received to a new order.

Subscriptions

No more subscription cards for you! Alexandria’s **Subscriptions** module does it all. Track all information pertaining to a subscription in one place — renewal dates, receipt of issues, missing issues, cost, etc. — it’s all here in one place.
Routes

Do you have professional magazines that you circulate to your staff? Alexandria will let you establish route lists and will automatically generate the appropriate one when an issue is received. Truly, Alexandria is a librarian’s best friend!

Additional Third-Party Add-Ons

COMPanion Corporation has partnered with several other firms to provide you with the best of the best in additional features. Contact our Sales Department (1-800-347-6439) to learn more about these features.

Sneak Peek

Sneak Peek provides cover art, summaries, reviews and much more.

netTrekker

netTrekker provides a database of educator reviewed, approved, and rated web sites tied to your state core curriculum standards. With netTrekker, a search in Alexandria’s Researcher will also search netTrekker to provide a wider selection of information choices for your students and teachers.

Search All

Search All is Alexandria’s federated search solution. Search Alexandria, the internet, and all your on-line databases at the same time. It’s the perfect “one-stop” searching tool for schools!
Capstone Interactive

Capstone Interactive provides ebooks and these may be accessed from within Alexandria.

Capstone Pebble Go

This interactive database of science information is wonderful for children and it can be accessed from Alexandria.

Technical Support and Product Updates

COMPanion offers technical support 24-hours a day, 365 days a year via toll-free telephone for customers with a support subscription (first year FREE). Alexandria also has built-in technical support features. Licensed users can update to the most current version of Alexandria by simply running a utility. This feature is disabled in this DEMO version, but is described to show how simple it is to update the software.

- Click on Tools on the menu bar and select Utilities.
- On the Utilities window, click on the Database tab and, then, on the Updates tab.
- Click anywhere in the utility listing, Updates - Check for Updates.

Hardware Recommendations

These are the hardware recommendations for Alexandria v6:

Macintosh
- Mac OS 10.6+
- G4, x86 Multi-Core processor
- 1 GB of RAM or more
- 20 GB of free HD/100,000 items

Windows
- Windows 7 or 2008
- Pentium 4 (or equivalent), x86 Multi-Core processor
- 1 GB of RAM or more
- 20 GB of free HD/100,000 items

Conclusion

A guided tour provides only an overview of the unique features and functionality Alexandria will offer your library. To find out more about how Alexandria’s advanced technology can benefit you, your school district, and your community, contact COMPanion.
For More Information Call Toll-Free
1-800-347-6439
International Call 801-943-7277
www.goalexandria.com